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Support

Please visit the HP OpenView website at:

http://openview.hp.com/ 

There you will find contact information and details about the products, services, and support that HP 
OpenView offers.

You can go directly to the HP OpenView eCare website at:

http://support.openview.hp.com/ 

The eCare support site includes:
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• Patches and updates
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• Training information
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Chapter 1
Overview

Frame relay networks eliminate error checking at the link layer by assigning responsibility 
for packet retransmission to higher level protocols. To avoid congestion, and the discards that 
result from congestion, the nodes in a frame relay network forward flow-control alerts to 
neighboring nodes and, when necessary, alter the discard-eligibility status of individual 
packets.

Although detailed reports about a frame relay network cannot prevent the frame format 
errors and the discards that result from such errors, detailed reports can detect congestion 
and put network operators in a position to respond to troublesome conditions faster than was 
possible without this information. A faster response to congestion means fewer discards; 
fewer discards means fewer retransmissions; and fewer retransmissions means that the 
committed information rate (CIR) is safe and reliable.

This chapter covers the following topics:

• Features and enhancements 

• Folders and the reports inside

• Ways to customize reports

• Integration with Network Node Manager (NNM)

• Sources for additional information

Features and Enhancements

The reports in the Frame Relay Report Pack display performance data for frame relay 
interfaces and permanent virtual circuits (PVCs). Reports about frame relay interfaces, also 
known as ports, display the following statistics:

• Number of frames sent/received

• Number of octets sent/received

• Number of frames discarded 

• Number of frames discarded due to errors

• Utilization 
7



Folders and the Reports Inside
Reports about PVCs display the following statistics:

• Number of committed-burst frames (color-coded green)

• Number of excess-burst frames (color-coded amber)

• Number of ODE frames (color-coded red)

• Number of frames indicating forward congestion (FECN)

• Number of frames indicating backward congestion (BECN)

This package includes Near Real Time reports, hourly reports, daily reports, monthly reports 
and reports that forecast performance 30, 60, and 90 days into the future. They also support 
multiple collection mechanisms (datapipes). The following datapipes are available:

• Frame Relay CPE Datapipe (for MIBs compliant with RFC2115)

• Ascend Frame Relay Datapipe (Lucent)

• Newbridge Frame Relay Datapipe (Alcatel)

• Stratacom Frame Relay Datapipe (Cisco WAN)

Frame Relay Report Pack version 4.0 provides support for Oracle as well as Sybase database 
software.

Folders and the Reports Inside

When you install this package, reports are created in the FrameRelay_Service directory. This 
directory has two child directories: Port and PVC. Reports in the Port directory relate to the 
logical port on the device, often equating to an entry in the ifTable of MIB-II. Reports in the 
PVC directory are one level more granular and show information about PVC endpoints or 
pairs of endpoints. An alphabetical list of reports follows, with a brief purpose statement for 
each type of report.

Availability. Highlights ports and PVCs reporting low availability for yesterday. The 
selection table is followed by hourly analysis of availability for a selected port or PVC.

Capacity Planning. Highlights Ports and PVCs that are expected to be either underutilized 
or overutilized 30 days from now.

Daily/Monthly QuickView. A list of overutilized ports and PVCs, followed by analysis of 
average and peak utilization for a specific port or PVC.

Daily/Monthly Snapshot. Same as the Daily QuickView, but limited in scope to specific 
ports or PVCs identified by the user just after launching the report. 

Executive Summary/Executive Summary by Region. A comparison of baseline 
performance to F30 for all ports or all PVCs, followed by monthly, daily, and hourly analysis 
of aggregated volume and aggregated errors. The report begins with either a list of customers 
or a list of regions.

Forecast. Highlights ports and PVCs that are expected to have the highest utilization levels 
30 days into the future. Rate of growth is calculated by dividing the F30 value by the baseline 
average. The baseline average is an average of daily busy hour values. Busy hour is defined in 
the Special Terms section of this chapter.

Hot Spots. Highlights ports and PVCs with high exceptions. The PVC version looks at 
utilization, congestion, and GOS exceptions; the port version looks at utilization, error, and 
discard exceptions. 
8



Chapter 1
NRT QuickView. A list of the most utilized ports and PVCs based on data collected (and 
averaged) over the last six hours. The selection table is followed by (1) analysis of peak and 
average utilization, (2) analysis of errors and discards, and (3) Grade of Service.

NRT Snapshot. Same as the NRT QuickView but limited in scope to ports or PVCs selected 
by the user when launching the report.

PVC Configuration Problems. A list of PVCs that have missing or incorrect CIR values. 
Any PVC with a CIR value of NULL or 0 will appear in this report.

Round Trip Delay. One version only of this report, for PVCs. Provides a list of PVCs 
experiencing the longest round trip delay. Not all datapipes collect this metric. See the release 
statement for the datapipe for details.

Top Ten. Identifies PVC endpoints and ports experiencing high utilization. Consists of two 
tables. The top table looks at yesterday’s performance; the bottom table looks at performance 
for the previous 30 days.

Ways to Customize Reports 

You can customize reports by applying group filters, by updating property data, and by editing 
parameters, tables, and graphs. In general, if you apply a group filter, your goal is to change 
the way the entire package appears to a group of users. If you edit a parameter, table, or 
graph, you are making a temporary change; any user is able to make this kind of change. For 
more information about editing tables and graphs, also known as selecting a different view 
option for tables and graphs, see Chapter 11, Editing Tables and Graphs.

Group Filters

If you intend to share your reports with customers, or let divisions within your enterprise see 
division-specific performance data, you will want these reports to be customer-specific, 
containing data limited to one customer. Creating customer-specific reports is an 
administrator task that involves the following steps:

• Adding customer names and device locations using the import utility (or the forms) that 
come with the Common Property Tables package

• Creating a group account for all of the users affiliated with a particular customer

• Creating a group filter for the group account

For more information about creating filters for group accounts, refer to the OpenView 
Performance Insight Administration Guide. 

Updating Property Data

For information on modifying PVC endpoint property data to be displayed in Frame Relay 
reports, see “Using Forms to Update Property Data” on page 25 and “Bulk Property Imports 
(Provisioning)” on page 29. 
9



Integration with Network Node Manager (NNM)
Report Parameters

If you edit a parameter, you are applying a constraint to the report with the intention of 
eliminating data you do not want to see. For example, if you edit the Customer Name 
parameter, data for all customers except the customer you typed in the Customer Name field 
will drop from the report; similarly, if you edit the Source Location, data for all locations 
except the location you typed in the Source Location field will drop from the report. 

Constraining the contents of a report by editing parameters is completely optional and you 
may apply multiple constraints at once. Frame Relay 4.0 supports the following parameters: 

• Customer Name

• Customer ID

• Location Name

• Location ID

• Device Name

• Port

• Dlci

• Make

• Model

Some reports support every parameter in this list, while most reports support a subset of this 
list. To edit parameters, click the Edit Parameters icon at the bottom right-hand corner of the 
report. When the Edit Parameters window opens, type the constraint in the appropriate field 
and then click Submit.

Tables and Graphs

By editing a table you can change the constraints, change the number of rows in the table, and 
display the contents of the table in a spreadsheet. The data in graphs is sometimes 
constrained by the amount of space available on the report. This problem can be easily 
overcome by re-displaying the graph in a new frame. These and other editing options for 
tables and graphs are covered in Chapter 11, Editing Tables and Graphs.

Integration with Network Node Manager (NNM)

The threshold-oriented reports in the Frame Relay Report Pack (in practice this means the 
Near Real Time reports) can be launched from NNM in response to an alarm. If you want to 
implement this feature, you must install the integration package before proceeding with the 
installation of the Frame Relay Report Pack. The integration package synchronizes devices 
and interfaces between NNM and OpenView Performance Insight (OVPI) and modifies 
various menu options on NNM, making it possible for the NNM operator to perform 
context-based report launching. 
10
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In addition to installing the integration package on the NNM server, you will need to install 
the Thresholds Module and the thresholds sub-package that comes with the Frame Relay 
Report Pack. The Thresholds Module monitors the database for threshold breaches, while the 
thresholds sub-package responds to a threshold breach by taking one of several possible 
actions. The default action is to send a threshold trap to the NNM server. 

Sources for Additional Information

The following documents are related to this manual: 

• Frame Relay CPE Datapipe 4.0 User Guide

• Interface Discovery Datapipe 2.0 User Guide 

• Thresholds Module 5.0 User Guide 

• Performance Insight / NNM Integration Module 2.0 User Guide 

• Frame Relay Newbridge Datapipe 4.0 Release Statement

• Frame Relay Stratacom Datapipe 4.0 Release Statement

• Frame Relay Ascend Datapipe 4.0 Release Statement

• Newbridge Preprocessor 3.0 User Guide 

• Newbridge Preprocessor 3.0 Release Statement 

• Stratacom Preprocessor 3.0 User Guide

• Stratacom Preprocessor 3.0 Release Statement 

The following documents are good sources for information about OVPI, the platform for HP 
OpenView reporting solutions:

• OpenView Performance Insight 5.0 Administration Guide

• OpenView Performance Insight 5.0 Guide to Building and Viewing Reports

• OpenView Performance Insight 5.0 Installation Guide

Manuals for OVPI and the reporting solutions that run on OVPI can be downloaded from 
the following web site:

http://support.openview.hp.com

Select Technical Support > Product Manuals to reach the Product Manuals Search page. The user 
guides for OVPI are listed under Performance Insight. The user guides for reporting solutions 
are listed under Reporting and Network Solutions. 

Each title under Reporting and Network Solutions indicates a date of publication. Because we 
post updated user guides to the Product Manuals Search page on a regular basis, be sure to 
check for updates on the web before using on older PDF that may no longer be current. 
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Chapter 2
Installing and Uninstalling Packages

This chapter covers the following topics:

• Guidelines for a Smooth Installation

• Prerequisite Tasks for Upgrade or Installation

• Procedure for Upgrading an Earlier Version

• Procedure for a New Installation

• Viewing Reports

• Procedure for Uninstalling Packages

Guidelines for a Smooth Installation

When you select OVPI components for installation from the Reporting and Network Solutions 
(RNS) 5.0 CD, the install script will copy every OVPI package to the Packages directory on 
your system. When this process is complete, the install script will prompt you to run Package 
Manager, which enables you to select the packages you want to install. Before beginning to 
install packages, become familiar with the following guidelines.

Software Prerequisites

Version 4.0 of Frame Relay Report Pack has the following prerequisites:

• OVPI 5.0 

• Any available Service Pack for OVPI 5.0

• Common Property Tables 3.0

• Interface Reporting Report Pack 4.0

Remove or Upgrade? 

In general, if you are running an older version of any package you are about to install, you 
must either remove that older package or install the upgrade package. Typically, datapipes 
get removed because there is no upgrade path, while report packs get upgraded because there 
13



Guidelines for a Smooth Installation
is an upgrade path. Therefore, if you are running an older version of Frame Relay, you must 
install the appropriate upgrade package. If you are currently running an older version of a 
datapipe, you must uninstall the older version before installing the new version. 

Datapipes

The following datapipes are available for Frame Relay data collection:

• Frame Relay CPE Datapipe (FRSCPE_Datapipe)

• Ascend Frame Relay Datapipe

• Newbridge Frame Relay Datapipe

• Stratacom Frame Relay Datapipe

You must install at least one datapipe. If you are already running an older version of a 
datapipe in this list, uninstall the older version before installing the new version.

Common Property Tables

The Frame Relay Service Report Pack 4.0 requires Common Property Tables version 3.0.

• If you are not currently running any version of Common Property Tables, simply let 
Package Manager install the correct version for you. 

• If you are running an older version of Common Property Tables, upgrade to the 
appropriate version by installing the appropriate upgrade package. Do this before 
installing or upgrading the Frame Relay Service Report Pack.

Installing the upgrade package(s) for Common Property Tables is easy, but if you need 
assistance with the installation or if you want to know more about how this package operates, 
refer to the Common Property Tables 3.0 User Guide. 

Integration with NNM: Threshold Alarms

If OVPI is integrated with NNM, you will probably want to install the optional thresholds 
sub-package, FrameRelay_Service_Thresholds.

This sub-package comes with the Frame Relay Report Pack. The thresholds sub-package 
contains customized threshold conditions specific to Frame Relay networks. When a threshold 
is breached, the thresholds sub-package responds by taking an action. If you have integrated 
OVPI with NNM, the action taken by the thresholds sub-package is to send an alarm to the 
NNM server.

If you select the thresholds sub-package for installation, Package Manager will automatically 
select the Thresholds Module, a package required by the thresholds sub-package. The 
Thresholds Module controls the actions that can be taken in response to a threshold condition. 
For information about configuring additional actions, refer to the Thresholds Module User 
Guide. 
14



Chapter 2
Distributed Environments

Keep these guidelines in mind when upgrading/installing the Frame Relay Report Pack on a 
distributed system:

• Make sure you have installed OVPI 5.0 on the central server and on each satellite server.

• Upgrade/install the report pack on the central server and on each satellite server.

• Upgrade/install the appropriate datapipe(s) on each server that polls for data. If the 
central server does not poll, do not upgrade/install the datapipe(s) on the central server.

After you have installed the Frame Relay Report Pack in a distributed environment, you must 
edit various process files that govern the way data is pulled from satellite servers by the 
central server. This task is covered in Chapter 3, Package Configuration.

Prerequisite Tasks for Upgrade or Installation

Complete the following tasks before upgrading or installing the Frame Relay Report Pack:

• Task 1: Extract the Packages

• Task 2: Upgrade to Common Property Tables 3.0

• Task 3: Uninstall Datapipes (if necessary)

Task 1: Extract the Packages

To extract the Frame Relay Service Report Pack packages from the RNS CD to the Packages 
directory on your system, do the following:

1 Log in to the system. On UNIX® systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services .

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the RNS CD. 

Windows: The Main Menu automatically displays. 

UNIX: 

a Mount the CD (if the CD does not mount automatically).

b Navigate to the top level directory on the CD.

c Run ./setup .
15



Prerequisite Tasks for Upgrade or Installation
4 Type 1 in the choice field and press Enter. 

The install script displays a percentage complete bar. When the copy is complete, the 
install script starts Package Manager. The Package Manager Welcome window opens.

5 Do one of the following:

• If you want to upgrade Frame Relay now, complete tasks 2 and 3, then go to 
“Procedure for Upgrading an Earlier Version” on page 17.

• If you want to install Frame Relay for the first time now, go to “Procedure for a New 
Installation” on page 19.

• If you do not want to install or upgrade at this time, go to Step 6.

6 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services .

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer start

— Sun: sh /etc/init.d/ovpi_timer start

Task 2: Upgrade to Common Property Tables 3.0

The Frame Relay Service Report Pack requires Common Property Tables 3.0. Upgrade to 
Common Property Tables 3.0 before upgrading the Frame Relay Service Report Pack. If you 
need help with the upgrade, refer to the Common Property Tables 3.0 User Guide. 

If this is a new installation of the Frame Relay Service Report Pack, install Common Property 
Tables 3.0 with the report pack. (This task is described in “Procedure for a New Installation” 
on page 19.)

Task 3: Uninstall Datapipes (if necessary) 

If you already have an older version of one or more datapipes that you want to upgrade, you 
must first uninstall the old version. The following procedure explains how to remove an old 
version of a datapipe. You can install the latest version of any datapipe when you install or 
upgrade the report pack, as explained later in this chapter.

To remove the old version of a datapipe, do the following:

1 Log in to the system. On UNIX systems, log in as root.

2 If it is not already stopped, stop OVPI Timer and wait for processes to stop running.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services .

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.
16



Chapter 2
On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer stop

— Sun: sh /etc/init.d/opvi_timer stop

3 Start Package Manager. 

a Launch OVPI and select Management Console.

b Select Tools > Package Manager.

The Package Manager Welcome window opens.

4 Click Next. 

The Packages Location window opens.

5 Click the Uninstall button and click Next. 

The Report Undeployment window opens.

6 Click Next. 

The Package Selection window opens.

7 Click the check box next to the name of each datapipe that you want to uninstall, for 
example, Ascend_FR_Datapipe or FRSCPE_Datapipe.

8 Click Next. 

The Selection Summary window opens.

9 Click Uninstall.

The Progress window opens. When removal is complete, a message appears.

10 Click Done to return to the Management Console.

Now that you have completed the prerequisite tasks, do one of the following:

• To upgrade Frame Relay Service Report Pack, go to “Procedure for Upgrading an Earlier 
Version” on page 17.

• To install Frame Relay Service Report for the first time, go to “Procedure for a New 
Installation” on page 19.

Procedure for Upgrading an Earlier Version

You have several upgrade options for Frame Relay, and each option is easy to perform. Your 
choices are listed in the following table. 

Existing Installation Upgrade Package To Use Finished Installation

Frame Relay 2.0 UPGRADE_FRS_2.x_to_3.0 Frame Relay 3.0

Frame Relay 2.5 UPGRADE_FRS_2.x_to_3.0 Frame Relay 3.0

Frame Relay 3.0 UPGRADE_FRS_3.x_to_4.0 Frame Relay 4.0
17



Procedure for Upgrading an Earlier Version
You must complete the tasks in “Prerequisite Tasks for Upgrade or Installation” on page 15 
before beginning the following procedure. If Package Manager is already running, begin this 
procedure at Step 5.

1 Log in to the system. On UNIX systems, log in as root.

2 If your system is distributed, disable trendcopy.

3 Launch OVPI and select Management Console. 

4 From the Tools menu, select Package Manager.

The Package Manager Welcome window opens.

5 Click Next. 

The Packages Location window opens.

6 Click the Install button. 

7 Approve the default installation directory or select a different directory if necessary. 

8 Click Next. 

The Report Deployment window opens.

9 Type your username and password for the OVPI Application Server. 

10 Click Next. 

The Package Selection window opens. 

11 Click the check box for the upgrade package you require. Package Manager may require 
you to upgrade other dependent packages at this stage.

You can also select the datapipe(s) you want to install at this time, or you can install them 
later. Data to populate the reports will be collected only after you install a current 
datapipe.

12 Click Next. 

The Type Discover window opens. 

13 To run Discover immediately after package installation, accept the default and click Next.

The Selection Summary window opens. 

14 Verify that the contents of this window are correct and click Install to begin the installation 
process. 

The Installation Progress window opens. When installation is complete, a message 
appears.

15 Click Done to return to the Management Console. 

If you are currently running version 2.0 or 2.5, you must perform the upgrade 
procedure twice: once to upgrade to version 3.0 and a second time to upgrade 
to version 4.0.
18
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16 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services .

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer start

— Sun: sh /etc/init.d/ovpi_timer start

Procedure for a New Installation

You must complete the tasks in “Prerequisite Tasks for Upgrade or Installation” on page 15 
before beginning the following procedure. If Package Manager is already running, begin this 
procedure at Step 5.

1 Log in to the system. On UNIX systems, log in as root.

2 If your system is distributed, disable trendcopy.

3 Launch OVPI and select Management Console. 

4 From the Tools menu, select Package Manager.

The Package Manager Welcome window opens.

5 Click Next. 

The Packages Location window opens.

6 Click the Install button. 

7 Approve the default installation directory or select a different directory if necessary. 

8 Click Next. 

The Report Deployment window opens.

9 Type your username and password for the OVPI Application Server. 

10 Click Next. 

The Package Selection window opens. 

11 Click the check box for the following packages:

• FrameRelay_Service 

• At least one of the following datapipes:

— Ascend_FR_Datapipe

— FRSCPE_Datapipe

— Newbridge_FR_Datapipe

— Stratacom_FR_Datapipe

• If you are implementing thresholding, select the FrameRelay_Service_Thresholds 
sub-package. 
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Viewing Reports
12 Click Next. 

The Type Discover window opens. 

13 To run Discover immediately after package installation, accept the default and click Next. 

The Selection Summary window opens. 

14 Verify that the contents of this window are correct, then click Install to begin the 
installation process. 

The Installation Progress window opens. When installation is complete, a message 
appears.

15 Click Done to return to the Management Console. 

16 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services .

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer start

— Sun: sh /etc/init.d/ovpi_timer start

Most report packs include a demo package. The demo package is independent of other 
packages and can be installed at any time. Demo reports are static; the data does not change 
from day to day, but the linking works. Tables are linked to graphs, and you can experiment 
with various options for viewing tables and graphs. 

Viewing Reports

Before reports can be viewed using a web browser, they must be deployed. When you installed 
the Frame Relay Report Pack, you enabled the Deploy Reports option. As a result, Frame 
Relay reports are deployed to the Application Server and are now available for viewing on the 
web. 

If the client component of OVPI was installed on your system, you have access to the Report 
Viewer and Report Builder applications, and you can use these applications to display reports. 
If the client component was not installed on your system, web access to reports is your only 
means of access. You can find more information about the client component in the OpenView 
Performance Insight Installation Guide. 

Seeing Performance Data 

Some reports populate with data sooner than others. The first report to populate with data is 
the Near Real Time report. You will begin to see data in this report immediately after the first 
data collection completes. 

Any report that begins with an analysis of yesterday’s performance will need at least one full 
day’s worth of data before results are viewable. You will begin to see forecast data soon, within 
a few days. However, reliable forecast data will not be available for several weeks.
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Procedure for Uninstalling Packages

If you remove a report pack, the associated tables and all the data in those tables will be 
deleted. If you want to preserve the data in those tables, archive the data before removing the 
package. 

Follow these steps to uninstall the Frame Relay Report Pack and any datapipe that depends 
on the report pack:

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services .

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer stop

— Sun: sh /etc/init.d/ovpi_timer stop

3 Open the Management Console.

4 From the Tools menu, select Package Manager.

The Package Manager Welcome window opens. 

5 Click Next.

The Packages Location window opens.

6 Select the Uninstall button and click Next.

The Report Undeployment window opens.

7 Keep the defaults and click Next.

The Package Selection window opens.

8 Click the check box next to the package named FrameRelay_Service.

Any dependent packages will be selected automatically.

9 Click Next.

The Selection Summary window opens.

10 Click Uninstall.

The Progress window opens. When removal is complete, a message appears.

11 Click Done to return to the Management Console.

12 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services .

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.
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On UNIX, as root, do one of the following:

— HP-UX: sh /sbin/ovpi_timer start

— Sun: sh /etc/init.d/ovpi_timer start
22



Chapter 3
Package Configuration

This chapter covers the following topics: 

• Configuring Distributed Systems

• Using Forms to Update Property Data

• Bulk Property Imports (Provisioning)

• Default Values for Thresholds

Skip the Configuring Distributed Systems section if you are running the Frame Relay 
package on a stand-alone system.

Configuring Distributed Systems

If you are running the Frame Relay Report Pack in a distributed system, you installed the 
report pack, the Thresholds Module, Common Property Tables, and Interface Reporting 
packages on the central server. If the central server is polling, you also installed one or more 
Frame Relay datapipes and the packages they depend upon.

On each satellite server you installed the report pack, a set of datapipes, and the required 
dependency packages. You now need to configure the central server and each satellite server. 
This is done by editing various files on the central server and each satellite server. 

Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Set up connections with satellite server databases

• Task 2: Configure trendcopy pull commands and modify the entry in OVPI Timer

Task 1: Set up connections with satellite server databases

1 Select HP OpenView > Performance Insight > Management Console.

2 Click the Systems icon on the lower left. 

The System/Network Administration pane opens.
23



Configuring Distributed Systems
3 Right-click the Databases folder. When prompted, select Add OVPI Database. 

The Add Database Wizard opens. 

4 Click Next.

5 Type the hostname and port number for the database you want to add; click Next.

6 Review the Summary. Repeat Steps 4 and 5 for each additional database.

7 Click Finish when you finish adding databases. 

Task 2: Configure trendcopy pull commands 

1 Open the following file:

$DPIPE_HOME/scripts/FrameRelay-Switch_trendsum_hourly.pro

2 Comment out the pvc and port summaries by adding the comment sign (“#”) before the 
begin and end statements.

3 Configure trendcopy pull commands from the central server for each satellite server. That 
is, uncomment the copy commands in the hourly_copy block and modify them as follows:

— Replace SATELLITE_SERVER_1_DATABASE with the satellite server name

— Replace THIS_MACHINE_DATABASE with the central server name

4 If there is more than one satellite server, create and configure new hourly copy commands 
for each additional machine. 

5 If you want to copy rate data from satellite servers to the central server, configure 
trendcopy pull commands from the central server for each satellite server. Within the 
same file ($DPIPE_HOME/scripts/FrameRelay-Switch_trendsum_hourly.pro), 
uncomment the copy commands in the rate_copy block and modify them as follows:

— Replace SATELLITE_SERVER_1_DATABASE with the satellite server name

— Replace THIS_MACHINE_DATABASE with the central server name

6 If there is more than one satellite server, create and configure new hourly copy commands 
for each additional machine. 

7 Make sure that all system clocks are synchronized. 

Copying polled rate data from each satellite server every hour 
increases traffic between satellite servers and the central server; 
copying polled rate data from each satellite server also increases 
the central server’s processing load.

Step 7 is extremely important. In a distributed environment, linked 
processes must execute in exact sequence across independent 
machines.
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Configuring a Satellite Server

Follow these steps to configure a satellite server.

1 Switch off daily aggregations by commenting out the lines referencing FrameRelay-
Switch_Daily.pro in the $DPIPE_HOME/lib/trendtimer.sched file.

2 Modify the FameRelay-Switch_Hourly.pro trendtimer entry in the $DPIPE_HOME/lib/
trendtimer.sched file. By default, this process starts at 40 minutes after the hour. To make 
sure the satellite server completes hourly summarizations before the central server 
begins hourly summarizations, change the start time from 1:00+40 to 1:00+25.

3 Configure polling policies for the Frame Relay CPE Datapipe, making sure that each 
network device is polled by one satellite server only.

4 Make sure that all system clocks are synchronized. 

Using Forms to Update Property Data

This section discusses the following forms:

• Change PVC Endpoint Customer

• Change PVC Endpoint Location

• Change PVC Endpoint Description

• Change PVC Endpoint Configuration

These forms are used to modify PVC property objects. Forms are available with OVPI 4.6 and 
higher. Forms do not allow you to create new PVCs, only to modify existing ones. 

Forms are context-sensitive and will display a list of every PVC that was selected in the object 
manager before the form was launched. The only PVCs that will be updated by the form are 
the PVCs that were highlighted. Use the forms carefully. Assigning the same property value 
to multiple PVCs is easy to do, but are you sure that is what you want to do? 

Do not perform this procedure if the satellite server is performing local 
reporting or if the thresholds sub-package is not installed on the satellite 
server.

Step 4 is extremely important. In distributed environments, linked 
processes must execute in exact sequence across independent 
machines.

To 

To create new nodes, locations, or customers, or to modify existing nodes, 
locations, or customers, use the forms that come with the Common Property 
Tables package. For details, see the Common Property Tables User Guide.
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Using Forms to Update Property Data
The Frame Relay forms modify properties for PVCs that already 
exist in the database. To launch a form, click the Objects icon in 
the panel on the left side of the Management Console window. 
The Object/Property Management view opens. Object Manager 
shows a list of objects. The type of object presented depends on 
which Object Manager View is open. 

The default view is the Device view, showing a list of devices. The 
Customer view shows a list of customers, the Location view shows 
a list of locations. To change the view, select View > Change View 
and use the pop-up window to select a different view.

When the type of object you are interested in updating is 
displayed, select the particular object you would like to update. 
When you select the object, Object Specific Tasks will appear in the 
window on the right. Double-click the update task to open the 

update form.

All OVPI forms are sensitive to the object that is currently selected. When the form opens, the 
data displayed is limited to the object you selected in the Management Console. The object 
could be an individual PVC endpoint, or a Device, or some other managed element such as a 
Customer. The currently selected object is displayed in the Object Details window.
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Change PVC Customer

Use the Change PVC Customer form to update the customer assigned to a PVC Endpoint. The 
selection list will include PVC endpoints for the object you have chosen to modify. Highlight 
only the endpoints you wish to make the change to. Use the drop down menu to choose a 
customer. Click Apply to save your changes. Note that if you assign a customer to an interface, 
it will trickle down to the PVC endpoints on that interface after a short time, if those PVC 
endpoints do not already have a customer assigned to them.

Change PVC Location

You can use the Change PVC Location form to update the location assigned to a PVC 
Endpoint. The selection list will include PVC endpoints for the object you have chosen to 
modify. Highlight only the endpoints you wish to make the change to. Use the drop down 
menu to choose a location. Click Apply to save your changes. Note that if you assign a location 
to an interface, the location will trickle down to the PVC endpoints on that interface after a 
short time, if those endpoints do not already have a location assigned to them.
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Change PVC Description

Use the Change PVC Description form to update the description of a PVC Endpoint. The 
description is often used to display connectivity or customer-related textual information. The 
selection list will include PVC endpoints for the object you have chosen to modify. Highlight 
only the endpoints you wish to make the change to. Use the text entry box to enter a new 
description. To save your changes, click Apply. 
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Change PVC Configuration

Use the Change PVC Configuration form to update all of the properties relating to a single 
PVC endpoint. Endpoints with no CIR set will be highlighted in red. Descriptions of each of 
the attributes is shown on the form. Modify each of the properties for the selected endpoint - 
to save your changes, click Apply. 

Bulk Property Imports (Provisioning)

The Frame Relay Report Pack allows you to store details about the PVCs you are managing, 
referred to as PVC endpoint properties. There are two primary ways to modify the properties 
of a PVC endpoint. One is to use OVPI forms, as described in “Using Forms to Update 
Property Data” on page 25. The alternative method is to use the supplied property import 
interface. You can use this interface to add the following information to managed PVC 
endpoints within the OVPI system and, thus, reports:

• Committed Information Rate (CIR)

• PVC endpoint pairs

• Customers and customer IDs

• Locations and location IDs

• PVC threshold percentage values for FECN, BECN and Discard Eligible frame counts.

CIR values are needed to calculate utilization for PVC endpoints, while ifSpeed is needed to 
calculate port utilization. If you are already collecting these values from all your network 
elements, and they are correct, you may skip this section. Use the PVC Configuration 
Problems report to verify if CIR and PVC Id have been set for all of your pvc endpoints.

To add the preceding list of properties to reports, or to correct incorrect properties, do one of 
the following:

• Use the file format guidelines provided later in this chapter to create your own property 
import file, then import it.

• Export existing data from the K_frswitch_pvc property table, modify it, and then import 
the new file.

If you choose to export data from OVPI, follow these steps:

1 Navigate to the DPIPE_HOME/scripts directory.

2 Type: trend_proc -f FrameRelay-Switch_exportdata.pro

This command calls an OVPI process that generates a tab-delimited flat file and, if the 
default SourceDirectory has not been changed, stores it in the PropertyData directory 
under FrameRelay_Switch.ap. The tab-delimited flat file has the following name:

FrameRelay_Switch_PVC_Property.dat.<timestamp>

3 Edit the tab-delimited file, adding new values or correcting incorrect values.

4 Import the file you just edited.

The export step can take place whenever you want and as often as you want. The import step 
is actually a scheduled process, it operates automatically every hour, and it operates in the 
same way whether you are working with a file you created yourself or a file that was exported 
from OVPI and then edited. 
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To run the import process automatically, just make sure that your property import file is 
stored where OVPI expects to find it. If the default has not been changed, the following 
SourceDirectory path will be used:

{DPIPE_HOME}/data/PropertyData/ 
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OVPI uses a .teel file in the DPIPE_HOME/lib directory to locate the property import file. The 
name of the TEEL file is FrameRelay_Switch_PVC_Property.teel.

Clearly, the TEEL file must provide the correct SourceDirectory path. The SourceDirectory 
path may have been changed after the Frame Relay Report Pack was installed.

To run the import process manually, ahead of the scheduled automatic import process, do the 
following:

1 Navigate to the DPIPE_HOME/scripts directory.

2 Type: trend_proc -f FrameRelay-Switch_importdata.pro

Add a New Row or Modifying an Existing Row?

If you intend to modify an existing entry in a property table, the first three columns in the 
import file—Node name, Port and Dlci—must match the values of a row in the property table. 
For example, if you have a Node Name of router1 with a Port value of 1 and a Dlci of 23 in 
your PVC property file, there needs to be a matching Node name of router1 with a Port value 
of 1 and a Dlci of 23 in the KV_frswitch_pvc property table view. If there is no match, a new 
row will be added to the property table. 

File Format Guidelines

If you create your own file, you have to either generate the file automatically from a network 
provisioning database, or build the file from scratch using a spreadsheet program. If you 
create your own tab-delimited file, obey these rules:

• Use the formats described below.

• Use all the columns shown in the file format tables.

• Use the columns in the same order. 

• Make sure your file does not contain quotation marks.

• Note that if a cust_id value is already in use for a different customer_name, the existing 
customer_name will not be modified to that which is included in the import file. cust_id is 
the unique field that binds elements to customers.

• Note that if a location_id value is already in use for a different location_name, the existing 
location_name will not be modified to that which is included in the import file. location_id 
is the unique field that binds elements to locations.

• Note that the node_name, port, and Dlci columns are the unique identifiers of the 
property table and must contain the same values that exist on the polled PVC.

• If you use a spreadsheet application, export the data from the spreadsheet back into a tab-
delimited file when you finish. 

• If you have a previously generated PVC import file from a Frame Relay version 2.0 
installation, you may use it for your current report pack; the import mechanism will 
convert it to the new format and add the extra columns required. 
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The following table describes the format of the PVC property import file.

COLUMN NAME DESCRIPTION

Node name The device name for the PVC.

Example: ‘router1’

Port The port name for the PVC. Often the ifIndex value, or 
the unique name of the interface.

Example: ‘101’ or ‘Serial0/1’.

You may refer to an interface by the ifIndex during 
import if you do not know the unique identifier being 
used by the application for re-indexing purposes; 
however, the system will always use the unique name 
for the export procedure.

Dlci The numerical Dlci for this PVC endpoint.

Example: ‘123’

CIR The Committed Information Rate in bits/second

Note: The report pack requires this value. Some 
devices provide it directly from the network. Check the 
PVC Configuration Problems report to see if any are 
not set.

Example ‘64000’

RevCIR Reverse Committed Information Rate in bits/second.

Example ‘64000’

Not used in default reports.

cust_id Unique integer value for each customer name

Reserved values include -2 and -1

Value should always be greater than 0.

Example: ‘30’

location_id Unique integer value for each location name

Reserved values include -2 and -1

Value should always be greater than 0.

Example: ‘25’

pvc_id Unique integer value for a pair of PVC endpoints.

Used to associate PVC endpoints together. Check the 
PVC Configuration Problems report to see if any are 
not set. The default value of -2 indicates it has not 
been set.

Example: ‘55’

location_name Location name associated with location_id value.

Example “North London”.

If the associated location_id already exists with a 
different location_name then this value will be 
discarded. Use the Common Properties package to 
update location_name / location_id value pairs.
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Default Values for Thresholds

The Frame_Relay_Thresholds sub-package imposes a sets of thresholds for PVC endpoints. 
When performance reaches one of these default thresholds, the thresholds sub-package sends 
a trap to the network management system. The following tables describes the condition 
behind each threshold and the severity of the alarm sent in response to the condition.

The following table provides a list of exception thresholds for PVC endpoints  

customer_name Customer name associated with cust_id value.

Example “Large Corp 1”.

If associated cust_id already exists with a different 
customer_name then this value will be discarded. Use 
the Common Properties package to update 
customer_name / cust_id value pairs.

dsi_descr A description for the PVC endpoint

Example: “Service Level 1” or

“Failover PVC”

FECN Percent The allowable percentage of packets which can be 
marked FECN above which a threshold event will be 
generated.

BECN Percent The allowable percentage of packets which can be 
marked BECN above which a threshold event will be 
generated.

DE In Deviance The percentage deviation of packets above yesterdays 
average DE In packet ratio which is considered within 
normal limits. A ratio of in packets marked DE above 
(the average value yesterday + this percentage) will 
result in a threshold event being generated.

DE Out Deviance The percentage deviation of packets above yesterdays 
average DE Out packet ratio which is considered 
within normal limits. A ratio of out packets marked DE 
above (the average value yesterday + this percentage) 
will result in a threshold event being generated.

COLUMN NAME DESCRIPTION

METRIC THRESHOLD SEVERITY?

DE_In_Ratio_Exceeded Dynamic value - N% above 
yesterdays average DE In ratio. 
N defaults to 10 if not set by the 
user (DE In Deviance).

MEDIUM

DE_Out_Ratio_Exceeded Dynamic value - N% above 
yesterdays average DE Out ratio. 
N defaults to 10 if not set by the 
user (DE Out Deviance).

MEDIUM
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No intervention on your part is necessary to enable the exception threshold values in the 
preceding tables. However, if you want to enable multiple types of traps or set up multiple 
trap destinations, you will need to make changes to the Thresholds Module. These changes 
are explained in the Thresholds Module User Guide. 

FECN_In_Ratio_Exceeded The ratio of inbound packets 
marked FECN to the total 
number of packets has exceeded 
the allowable threshold during 
this poll cycle (FECN Percent).

MEDIUM

FECN_Out_Ratio_Exceeded The ratio of outbound packets 
marked FECN to the total 
number of packets has exceeded 
the allowable threshold during 
this poll cycle (FECN Percent).

MEDIUM

BECN_In_Ratio_Exceeded The ratio of inbound packets 
marked BECN to the total 
number of packets has exceeded 
the allowable threshold during 
this poll cycle (BECN Percent).

MEDIUM

BECN_Out_Ratio_Exceeded The ratio of outbound packets 
marked BECN to the total 
number of packets has exceeded 
the allowable threshold during 
this poll cycle (BECN Percent).

MEDIUM

METRIC THRESHOLD SEVERITY?
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PVC EndPoint QuickView and Snapshot

QuickView and Snapshot reports are available in three time ranges:

• Daily — showing hourly statistics for the previous day

• Monthly — showing daily statistics for the previous month

• Near Real Time — showing averages compiled over the previous six hours.

This type of report focuses on utilization in the selection table but provides Grade of Service, 
frame type and utilization frequency measurements in the graphs below for the selected 
element. The selection table at the top drives the contents of the other areas on the report. 

The data in the selection table shows averages for yesterday as a whole while the graphs and 
charts are on an hourly basis for yesterday through to the most recently summarized hour 
today. The selection table contains average, peak and busy hour utilization values. In the 
context of this report these columns have the following meaning:

• Average — the average utilization for the entire day

• Peak — the maximum utilization value recorded for a poll cycle during the entire day

• Busy Hour — the hour of day during which the highest hourly average was recorded.

When you select the QuickView version of any report, it displays immediately, the contents 
are limited only by the parameters you have applied, or by the object model. When you open a 
Snapshot report, you will be prompted to designate a subset of elements for viewing. In a very 
large network, using the Snapshot report will reduce the amount of data in the report and 
allow you to focus on the devices that interest you.
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Chapter 5
Port NRT QuickView and Snapshot

QuickView and Snapshot reports are available in three time ranges:

• Daily — showing hourly statistics for the previous day

• Monthly — showing daily statistics for the previous month

• Near Real Time — showing averages compiled over the previous six hours.

The top selection table of Near Real Time reports is an aggregate of all the poll cycle values 
for the previous 6 hours. 

The Port NRT QuickView focuses on utilization, discards and errors. The selection table at the 
top drives the contents of the other areas on the report. The lower graphs and charts use the 
most granular collections available for the report, showing the highest level of detail.

When you select the QuickView version of any report, it displays immediately. The contents 
are limited only by the parameters you have applied or the object model. When you open a 
Snapshot report, a window opens allowing you to select the element or elements you want to 
view. For a large network this will allow you to reduce the amount of data in the report and 
only show the devices you are interested in.

If you are using the FRSCPE_Datapipe, the Port reports in the Frame Relay Report Pack use 
MIB-II ifTable collections for interfaces of type Frame Relay. As such, they represent the same 
data that is collected in the Interface Reporting Report Pack, the OVPI MIB-II reporting 
suite. Users may find it useful to examine the Interface reports in that package when looking 
for port/interface information.
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Chapter 6
Port Executive Summary

The Port Executive Summary report conveys a clear picture of utilization on a customer-by-
customer basis. This report aggregates data at the customer level, providing monthly, daily 
and hourly coverage of volume and error counts. What you will not find in this report are 
statistics for specific ports. 

The Port Executive Summary contains one line graph and the following bar charts:

• Monthly volume for all ports — total volume both in and out for all ports associated with 
this customer aggregated for monthly periods.

• Monthly error count for all ports — total error counts both in and out for all ports 
associated with this customer aggregated for monthly periods.

• Daily volume for all ports — total volume both in and out for all ports associated with this 
customer aggregated for daily periods.

• Daily error counts for all ports — total error counts both in and out for all ports associated 
with this customer aggregated for daily periods.

• Hourly volume for all ports — total volume both in and out for all ports associated with 
this customer aggregated for hourly periods.

• Hourly error counts for all ports — total error counts both in and out for all ports 
associated with this customer aggregated for hourly periods.

As explained in Chapter 3, “Configuration,” you can assign a customer to a PVC, and you have 
two ways of doing it: by importing the customer name as property data, or by using a form. If 
a customer is assigned to the parent object of a PVC it will trickle down to the PVC level, but 
only if customers have not been set yet. For example, assume a device has 10 interfaces, and 
each interface has 2 PVCs on it. If you assign Customer A to PVC 1 on Interface 1 and 
Customer B to the device itself, the results we be as follows: Every PVC on the device except 
PVC 1 on Interface 1 will belong to Customer B.

The total of in and out traffic can sometimes lead to double counting frame, if 
both the in and out ports are associated with the same customer.
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PVC Configuration Problems

PVC Configuration Problems is designed to highlight mis-configured PVC objects in your 
OVPI database. If a PVC appears in this report, that does not indicate that the PVC is 
incorrectly configured for your network. 

This report focuses on two aspects of the PVC object:

• CIR

• PVC Id

Having a valid CIR value is essential if any type of utilization reporting or threshold alarming 
will be performed for the PVC endpoint. As this forms the core functionality of many of the 
Frame Relay reports, it is important that the CIR for every PVC endpoint is set correctly.   
The report pack attempts to gather CIR information from two sources on the network, 
RFC1315 and the Cisco Frame Relay MIB. If it is not available in either MIB table then the 
CIR will remain with a NULL setting. It is quite possible that a CIR of 0 bits per second will 
be provided by the network. This is a valid value in that you may have provisioned a ‘best 
effort’ service for the PVC, but it will result in divide by 0 errors when calculating utilization. 
Rows with this setting are typically not displayed in reports. It is better to assign the full 
ifSpeed of the interface the PVC terminates on, as this will be the maximum bandwidth 
available to the PVC.

There are three ways that CIR values can be updated:

• Updated by the network (RFC1315 or the Cisco Frame Relay MIB)

• Updated by the property provisioning file

• Updated by using Object Manager forms 

The PVC Id is an integer value which is associated with the two ends of a single PVC. It is 
used in the End to End reports. Not supplying a PVC Id value for each PVC Endpoint will not 
effect most reports, but will limit what data can be displayed in the End to End reports. It is 
advisable, but not essential, to populate this field.

There are two ways to update PVC Id values:

• Property provisioning file

• Object Manager forms 

See Chapter 3, Package Configuration, for more information about importing property 
information, including CIR and PVC Id.
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Top Ten PVC Endpoints

There are two Top Ten reports, one for ports and one for PVCs. Each provides a list of the top 
ten elements sorted by average utilization over the time period. The daily section of the report 
looks at statistics for the previous day and the monthly looks at statistics for the previous 
calendar month.

The first selection table in the PVC Endpoint report looks at average and peak utilization 
levels for yesterday. It provides a list, in descending order, of the ten PVC endpoints that 
reported highest average utilization in either direction, In or Out. In addition to listing the 
PVC endpoint and CIR, this table indicates utilization values for:

• Average In

• Average Out

• Peak In

• Peak Out

Selecting an endpoint from the list displays additional information about the device itself and 
the customer and locations associated with the PVC endpoint. 
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Chapter 9
PVC Endpoint Forecast

The PVC Endpoint Forecast focuses on growth rates. The growth rate for utilization is 
calculated by projecting utilization 30 days into the future and dividing the increase by the 
current baseline average for that day of the week. The higher the difference between the 
current average and the projected value, the greater the rate of growth. Use this report to 
identify problems long before they become critical.

Each row in the selection table describes one PVC endpoint. The endpoints are sorted in 
descending order by rate of growth. In addition to listing endpoints in growth-rate order, this 
table indicates:

• Day of week

• Projected in utilization 30 days into the future

• Baseline utilization

• Projected out utilization 30 days into the future

• In ratio of growth

• Out ratio of growth

When you highlight an endpoint in the selection table, the following data appears in the 
tabbed area.

• Basic: Compares in and out average utilization for the day to the busy hour utilization for 
the day.

• In Util Standard: Compares IN utilization to median IN utilization. The tab shows the 
baseline, the median, baseline utilization -1 standard deviation and baseline utilization 
+1 standard deviation.

• Out Util Standard: Compares OUT utilization to median OUT utilization. The tab shows 
the baseline, the median, baseline utilization -1 standard deviation and baseline 
utilization +1 standard deviation.

• In Util Advanced: Compares baseline IN utilization to forecasted IN utilization 30, 60 and 
90 day into the future. The date at the bottom of the tab represents the start date that the 
forecast calculation data is taken from.

• Out Util Advanced: Compares baseline OUT utilization to forecasted OUT utilization 30, 
60, and 90 days into the future. The date at the bottom of the tab represents the start date 
that the forecast calculation data is taken from.
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Chapter 10
PVC Endpoint Availability

The availability report allows you to focus on PVCs and ports that have been unavailable for 
any reason. In this context, an unavailable PVC is a PVC that is out of operation. Scheduled 
maintenance as well as failures will take ports and PVCs out of operation.

Availability is measured as a percentage of time over the time period that the port or PVC was 
considered to be operational based on metrics such as ifOperStatus, sysUpTime, ifLastChange 
and Circuit State, on the device.

The selection tables list PVC endpoints that had less than 100% availability over the day or 
month, while the hourly and daily bar graphs illustrate when the problems happened and for 
how long. Each bar in the hourly chart represents one hour in a 24 hour period, the bars in the 
daily chart represent one day in the previous month.
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Chapter 11
Editing Tables and Graphs

Tables and graphs can be viewed in several ways. Although the default view is usually 
adequate, you can easily increase the size of tables and you can easily alter the style of graphs 
by selecting a different view option. If you are using the Report Viewer application, right-click 
the object and select a different view. If you are looking at a report using the Web Access 
Server, click the Edit Table icon or the Edit Graph icon.

View Options for Tables

Right-clicking a table, or clicking Edit Table, opens a list of table view options.

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time.
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View Options for Tables
Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens.
Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 
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View Options for Graphs

Right-click any graph to open a list of view options. 

The following table provides details about each option.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph display data in a 
spreadsheet.

Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines

Legend Delete or reposition the legend. 

Style See the illustrations below.

Change Max Rows... Same as the table option shown above.

Display Data Table See below.
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View Options for Graphs
Style Options

Select Style to display a list of view options for graphs.

Export Element as CSV... Same as the table option shown above.

View in New Frame Opens graph in a Graph Viewer window.

Print Graph Same as the table option shown above.

Option Function
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables.
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View Options for Graphs
Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below.

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten.
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Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers.

Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day.

If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day. 
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View Options for Graphs
Display Data Table

This option changes a graph into a spreadsheet. 

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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Backward Explicit Congestion Notification (BECN)

A specific bit in the header of the frame relay packet and a method for preventing a congested condition 
from getting worse. If a node becomes congested, changing the value of the BECN bit to 1 will signal 
congestion to the upstream node and attached user devices.

Busy Hour 

The definition varies depending on what is being measured. Busy hour is either a busy hour total, or a busy 
hour average. A busy hour total points to the hour of the day that recorded the highest number of events, for 
example, the highest number of discards or the highest number of errors. A busy hour average points to the 
hour of the day when the average of multiple samples was highest (in the case of utilization) or lowest (in the 
case of throughput). Busy hour is a persistent event and should not be confused with peak, which could be 
very brief. If the value for busy hour seems high, keep in mind that actual utilization during the course of 
that hour may have been significantly higher.

Congestion 

The point at which the network cannot keep up with entering traffic and begins flow control. The network 
reaches severe congestion when an increase in the number of retransmissions begins to lower actual 
effective throughput. To recover from this condition, the network notifies end devices to reduce traffic. 

Committed Information Rate (CIR) 

The rate at which the ingress interface and the egress interface transfers information to a destination under 
normal conditions.

Data Link Connection Identifier (DLCI)

A number inside the header of a frame relay packet that identifies a virtual circuit 
corresponding to a particular destination. 

DE frames

Number of frames eligible for discard. A DE frame is created when the remote DTE sets the DE flag.

Discards

The number of frames that were discarded. Higher level protocols detect discarded frames and request a 
retransmission.
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Discard Eligibility

A specific bit in the header of a frame relay packet and a mechanism for identifying which frames should be 
discarded if the network becomes overloaded. When a CPE device or a network switch sets the DE bit to 1, 
the frame is above the Committed Information Rate (CIR) and therefore eligible for discard if congestion 
arises. A frame with a DE set to 1 will be discarded before non-discard eligible frames. 

Errors

The number of frames that were discarded because of errors. The following conditions are considered errors 
and will cause the frame to be discarded: (1) the frame was too long, (2) the frame was too short, (3) the 
DLCI value was invalid or unrecognized, (4) a value in the header was incorrect.

Forward Explicit Error Notification (FECN)

A specific bit in the header of the frame relay packet and a method for preventing a congested condition 
from getting worse. If a node becomes congested, it can set the value of the FECN bit to 1, thereby signally 
congestion to the downstream node and attached user devices.

Frame Types

There are three types of frames: unmarked frames, frames marked Discard Eligible (DE), and 
frames marked ODE. Frame types are color-coded. Unmarked frames are green; DE frames 
are amber, and ODE frames are red. Because most switch vendors do not mark frames ODE, 
your reports will not show statistics for red frames unless your switch vendor supports ODE. 

Frequency Distribution

QuickView and Snapshot reports include frequency distribution pie charts that show the 
percentage of samples falling within a specific ingress/egress or in/out utilization range for 
each hour of yesterday, or each day over the course of the last thirty days. The ingress and 
egress ranges for PVC endpoint utilization are:

• 0 - 80%

• 80 - 90%

• 90 - 100%

• > 100%

The in and out ranges for port utilization are:

• 0 - 50%

• 50 - 60%

• 60 -70%

• 70 - 100%
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Grade of Service

Quickview, Snapshot, and Hot Spots include Grade of Service charts. A Grade of Service is a ranking 
derived from a weighted average. The following table explains the grading behind scores for PVC 
endpoints. It shows the metrics the grade is based on, the weighting factor assigned to each metric, and the 
performance parameters for each of four possible grades. 

The following table explains the grading behind scores for ports. It shows the metrics the score is based on, 
the weighting factor assigned to each metric, and the parameters for each of four possible grades.

Near Real Time (NRT)

A report containing a rolling average for performance over the last six hours. The most recent 
data in this report was collected by the most recent poll, which probably took place within the 
last 15 minutes. 

Peak

The highest of several samples (typically, the highest of four samples if polling is taking place every 15 
minutes) recorded over an hour. Each hour produces one peak. 

Port

Any frame relay interface on any network device that supports MIB-II. 

GRADE 
CALCULATION

AVERAGE 
UTILIZATION

AVERAGE 
PERCENT RED 
AND/OR AMBER 
FRAMES

AVERAGE 
PERCENT 
CONGESTION

Weighting 60% 20% 20%

Excellent Range 0 - 80% 0 - 5% 0 - 5%

Good Range 80 - 90% 5 - 7% 5 - 7%

Warning Range 90 - 100% 7 - 10% 7 - 10%

Critical Range Over 100% Over 10% Over 10%

GRADE 
CALCULATION

AVERAGE 
UTILIZATION

AVERAGE 
PERCENT RED 
AND/OR AMBER 
FRAMES

AVERAGE 
PERCENT 
CONGESTION

Weighting 60% 20% 20%

Excellent Range 0 - 50% 0 - 5% 0 - 5%

Good Range 50 - 60% 5 - 7% 5 - 7%

Warning Range 60 - 70% 7 - 10% 7 - 10%

Critical Range Over 70% Over 10% Over 10%
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Permanent Virtual Circuit (PVC)

A fixed path not available on demand or on a call-by-call basis. The location of the beginning and the end of 
the circuit do not change, although the actual path taken through the network may vary if automatic 
rerouting takes place.

PVC Endpoint

The logical end point for a circuit. Typically this is defined by a combination of the device name, the MIB-II 
interface name and the Dlci number.

Utilization

Calculated at a PVC Endpoint by dividing the actual traffic on the circuit by the Committed Information 
Rate. Calculated at the Port or interface level by dividing traffic counts by the ifSpeed of the Port.
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